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1. Introduction 

1.1. What is MPEG-4 IR Network Camera? 
The MPEG-4 IR Network Camera (hereinafter call to UNC7710) is an Internet-based digital video 

surveillance device with a built-in Web server. It uses TCP/IP to distribute compressed live video over a 

Local Area Network (LAN) and/or the Internet through an Ethernet connection. 

 

The UNC7710 combines the features of a network camera with an infrared illuminator to provide good 

image quality, even in darkness. The built-in Web server makes it possible to monitor and control it 

remotely while delivering clear MPEG-4 video. It's ideal for surveillance systems that operate in both day 

and night conditions. 

 

The UNC7710 is self-contained Web Server. Users could access the camera just like browsing website 

over Internet using standard browser such as Microsoft Internet ExplorerTM, and do all the management, 

configuration, and monitoring easily. 

 

The UNC7710 contains an MPEG-4 image compression chipset capable of delivering streaming, constant 

or variable bit rate MPEG-4 video over the network in real-time. 

 

The PoE models built-in support for Power over Ethernet allows the camera to receive both data and 

power over a single Ethernet cable. 
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1.2. Key Features 
 

 Day & Night functionality for 24-hours surveillance, auto activate IR illuminator in low illumination. 

 Improved image quality in low-light and even in complete darkness. 

 Infrared radiant distance up to 30 meters. 

 Aluminum outdoor housing with IP 66 waterproof standard. 

 PoE models allow the camera to receive both data and power over a single Ethernet cable 

 Self-Contained HTTP Web Server providing Internet capability for remote access. 

 Active-X control for Microsoft Internet ExplorerTM providing maximum performance. 

 MPEG-4 and MJPEG video compression formats. 

 Supports resolution up to 30/25 fps @ Full D1 (720 x 480 / 720 x 576). 

 Video/Audio recording supports Windows Media PlayerTM playback. 

 DDNS support for dynamic IP application. 

 3-layer User Security Control. 

 Remote Upgradeable firmware and user content pages via FTP. 

 Server operating control through CGI based script easy to integrate the application for users. 

 Hardware watchdog providing robustness system in critical environment. 

 Video stream supported by many media players including QuickTime™ 
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2. Hardware Installation 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Power Cord 

2 1

 Non PoE model: Connects to the AC power outlet. 

 PoE model: The AC power is not necessary. The camera will get the power from the Ethernet 

cable. Please follow the below figure for the connection. 

 

2. Ethernet Connector 
Standard 10 /100 Base-T port connects to a CAT5 cable with RJ-45 connector. If you are using the 

camera with built-in PoE, please follow the below figure for the connection. 

 

 
 



 

3. Installation 

3.1. Installation Preview 
There are 2 mains steps required to perform a successful installation: 

 Software installation 

 Network configuration 

 

Software installation consists of the installation of software that is necessary to properly view the video 

from the camera or to configure the camera itself. The software includes: 

 IP Installer -- a utility for locating devices and configuring network settings on a LAN. 

 Component Installer -- installs all ActiveX components used by the device for things such as video 

display and configuration. 

 Adobe® Flash Player -- necessary for displaying some components of the Web UI. 

 

The following are not necessary, but may be used for added convenience: 

 Recording Software -- displaying and recording up to 16 channels simultaneously. Both the MPEG-4 

and MJPEG devices are supported. 

 Xvid -- a MPEG-4 codec. If no other MPEG-4 codecs (ie. DivX, 3ivX, ffdshow, etc.) are installed on 

your computer, the Component installer will install this for you. 

 QuickTime or VLC -- though not necessary, this can be used for viewing the MPEG-4 stream without 

a Web browser. 

 

Network configuration consists of modifying the network settings for the camera in order to successfully 

connect to the device. 
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3.2. Software Installation 
With the exception of the Macromedia Flash Player all the software that is necessary for the proper display 

and use of the UNC7710 is available on the included CD or from the Web site. For the following installation 

procedures it is assumed that all installation media will be taken from the CD. 

 

IP Installer 
The IP Installer is used to locate and configure network cameras and video servers on the LAN. This 

utility is useful for conveniently configuring the network settings of the camera, or for finding a device 

once the network settings have been modified.  

To install the IP Installer, from the installation CD UI, select IP installer, then follow the on screen 

instructions. 

 

Adobe® Flash Player 
Please visit the Adobe® Web site at http://www.adobe.com/downloads/ to download and install the 

Flash Player. 
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3.3. Network Configuration 
IP Installer is a utility that provides an easier, more efficient way to configure the IP address and network 

settings of the network camera. It even provides a convenient way to set the network settings for multiple 

devices simultaneously using the batch setting function. Moreover, IP Installer can save the network 

settings for all devices as a backup and restore them when necessary. 

 

– Preparation before IP Assignment 
 Always consult your network administrator before assigning an IP address to your server in order to 

avoid using a previously assigned IP address. 

 Ensure the network camera is powered on and correctly connected to the network. 

 MAC Address: Each network camera has a unique Ethernet address (MAC address) shown on the 

sticker of the camera as the serial number (S/N) with 12 digits (e.g. 000429-XXXXXX). 

  

 One final note, although the IP Installer is able to find and configure any network camera on the LAN 

except those that are behind a router, it is a good idea to set the host PC to the same subnet. In order 

to connect to the Web-based user interface of the network camera, the host PC must be in the same 

subnet. For more information about subnets, please consult your network administrator. 

 

– Using IP Installer 

Assigning an IP Address to UNC7710 

1. Once IP Installer has been successfully installed on the computer, double click the IP Installer icon 

on the desktop, or select it from Start > Programs > IP Installer. 

 

2. The IP Installer window is displayed below. 

3. Click the menu bar Tool > Search Network Device to search the network camera in the LAN. 
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4. From the list, select the device with the MAC Address that corresponds to the device that is to be 

configured. The MAC Address is identical to the unit’s S/N (Serial Number). 

5. Double click the item to open the Property Page dialog box for the selected device or click the 

menu bar View > Property. 

 

6. After filling in the properties, click [Synchronize] button to complete the configuration settings and 

save in the network camera and PC immediately. 

If click [OK] button, the configuration is only be saved in the PC. 
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Opening the Web-based UI from IP Installer 

1. To access the Web-based UI of the selected unit, run the View > Open Web on the menu bar.  

2. If the device has been configured correctly, the default Web browser will open to the home page of 

the selected device. 

3. If you find your browser is opened and automatically connected to the network camera Home 

Page, it means you’ve assigned an IP Address to the unit successfully. Now you can start to use 

the network camera. 

 

 

Verify and Complete the Installation from Your Browser 

When browsing the Home Page at the first time with the Microsoft Internet ExplorerTM, you must 

temporarily lower your security settings to perform a one-time-only installation of the ActiveX 

component onto your workstation, as described below. 

1. From the Tools menu, select [Internet Options] 

2. Click the [Security] tab and then click [Custom Level] button to see your current security 

settings. 

3. Set the security level to Low and click [OK]. 

4. Type the URL or IP address of your network camera into the Address field. 

5. A dialog box will pop up asking if the ActiveX control should be installed. Click [Yes] to start the 

installation. 

6. Once the ActiveX installation is complete, return the security settings to their original value, as 

noted above. 



 

4. Usage of Web-based User Interface 
Start your Web browser and enter the IP Address of your UNC7710 in the Address field. The Home page of 

the camera is now displayed: 

 

 

 

 

The status of the 
video stream 

 

4.1. Browse Live Video 

– Menu Language Selection 
The online Web-based User Interface ca

Traditional and Simplified Chinese. 

Such display will not affect the original c

different languages concurrent views. In

modified through the Configuration page

 

– Style Selection 
The Web-based User Interface can allow

to display: Simple and Graphic. 

Change the display style will not affect th

 

 

Full Screen 
Maximizes to view the selected
channels into full screen
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n allow the user to select 3 different languages: English, 

onfiguration for the language, allowing multiple users to have 

 order to make the language change permanent, settings must be 

. 

 the user to select the style 

e functions of the Web UI. 
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Select the Channel

– Video Channel Selection 
The Video Channel item allows the users to select viewing 1 channel at a time or 4 channels at the same time. 

CH1 displays the video stream of the UNC7710. 

CH2~4 display the video stream of the IP Camera or Video Server that connected the device via network. 

 Select [All] to display the local video stream (Channel 1) as well as 3 external video sources (Channel 

2 ~4). 

 Select 1~4 to display the video stream of single channel. 

 Select “Actual” to display the video stream at the actual 

resolution. 

 

– On/Off the Audio, and Rotate the Video 
The [Video Status] item allows the users to see the current s

of the selected channel. It also provides the function for audio con

video rotation and record the video/audio for the selected chann

 

he tab, and the status for the selected 

On/Off the Audio

Click the number on t

channel will be displayed. The settings can be setup in 

Configuration page. 

 

] button beside Audio to enable or disable the Select [On] or [Off

audio from the selected channel. 

Rotate the Video 

Click on [Rotation] button to temporary rotate the selected video on 90 degrees clockwise direction. 

This features that natural view for cameras that are hooked up on walls and/or vertical positions. 
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4.2. Recording the Video and Audio 
Before recording, you can check the settings of recorded file by clicking on [Recording Setting] item and 

change the setting if needed. The detail settings can be changed in Video Conference page. 

 With factory defaults, the recorded file will be saved in a folder 

named C:\MVS\Recfile\pppp\CHx\ 

♦  pppp : The model number of the device 

♦  x : The number of the recorded channel 

 The default filename will be named under           

Locals_Rec-yyyymmdd-hhmmss.avi 

♦  yyyy : Current Year 

♦  mm : Current Month 

♦  dd : Current Date 

♦  hh : Current Hour 

♦  mm : Current Minute 

♦  ss : Current second 

 

To record the video and audio: 

1. Click the [Video Status] item. 

2. Click the channel number on the tab. 

3. Click on [Record] button, it will start to record live video 

and audio of the selected channel. A “REC” message will 

display on the video. 

4. The Web UI can record multiple channels at the same time. 

To record the other channel, just repeat the step 2 and 3. 

5. To stop the recording, select the channel from the tab and 

then click [Stop Rec] button, the “REC” message will 

disappear and the recording is stopped. 

 The file will be saved as an AVI file, which can be play back 

with most media players including Windows Media PlayerTM. 

 The video is always recorded with the actual direction. It will not 

be affected by the rotation of viewing. 
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4.3. Video Conference 
Click [Video Conference] to open the conference page. 

 

 

 
 

 

 

Click this button backs 
to the Home page 

Click this button to open 
the Configuration page 

On/Off the audio of 
this video stream 

Rotate this video for 
viewing 

Record 
Start recording

Stop 
Stop recording

Setting 
Configure the settings 
for Recording 

Camera 
Select the remote 
device 

– Setting for Recording 
You can change the settings for recording by clicking 

on [Setting] button in Location window. 

 Reserve Space: Set the total file space for the 

recording. 

 Max File Length: Set the file space that a single 

will be using. 

 Save File Path: Indicate which folder should be 

the file saved to. 

 Location File Name: Input the name for the file 

that recorded from the location device. 

 Remote File Name: Input the name for the file th

recorded from the remote device. 

at 

ld  Cycle Recording: This feature indicates if the o



 

ra 

y 

space should be used or not for the recording. Make a checkmark in order to enable this function. If 

you enable this feature, old files will be deleted 

 Sync to TimeStamp: This feature enables the file to be saved according to the time. When the video 

file is displayed, the video will make a match between the frames and the time. 

 Apply: Click this button to save the changes made. 

 Return: Click this button returns to the live video of the location device. 

 Record/Stop: Click [Record] button to start recording. Click [Stop] button to stop the recording. 

 

– Select the Remote Device 
Click on the arrow button and select the came

from the pull-down list, the video of the remote 

device will be displayed. 

There are 4 cameras can be selected as the 

Remote device. The first three are set up in the 

Configuration page; the last one can be set up b

clicking [Camera Manual Setting] button. 

If the remote device is a PTZ model or controls a PTZ, click [Open PTZ] button to open a PTZ control panel 

to control the device. See 4.4 Control PTZ Devices for the instruction. 

– Manually Set Up Additional Camera 
This feature allows the user to temporary set an additional video source for the remote device. 

C

. 
Note: This camera will be removed after leave or close the Web page
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lick on [Camera Manual Setting] button on the Remote window, and set up the following settings: 

 IP address: Enter the IP address of the external 

source. 

 Http Port: Enter the port number of the external 

source. 

 Username/Password: Enter the respective 

Username and Password if applicable. If no user 

has been set for the device, the default value 

should be root and pass respectively. 

 Video Channel: If the selected camera is 

connected to a Video Server, select the channel o

the Video Server. 

f 

ype  Video Type: Select MJPEG or MPEG4. The t

must match the external source provided. 



 

 Rotation: Rotate the video for view. Rotation degrees run from 0 to 270 degrees. 

♦ 0: 0 degree 

♦ 1: 90 degrees 

♦ 2: 180 degrees 

♦ 3: 270 degrees 

 RTSP Port: Enter a RTSP Port used for streaming in case the external source is a MPEG4 device. 

 Name: Enter a name for the external source. 

 PTZ Model: Enter a PTZ model in case the external source is a PTZ model or controls a PTZ. 

 Product Type: Select from MJPEG or MPEG4 Video Servers or IP Cameras. Please refer to the 

original document of the device for a better description. 

 Apply: Click this button to save the changes made. 

 Test: Click on this button to validate the video connection and the live video will be displayed if the 

settings are correct. 

 Return: Click this button returns to the live video of the remote device. 
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4.4. Control PTZ Devices 
There are two items allows user to open the PTZ control panel to control the PTZ devices: 

 Click on [CH2~4 PTZ Control] item on Home page: This function allows the users to do the PTZ 

control in case the external source on channel 2 ~ 4 is a PTZ model or control a PTZ. 

 Click on [Open PTZ] button on Video Conference page: This function allows the users to do the PTZ 

control in case the remote device is a PTZ model or controls a PTZ. 

To control the PTZ device, follow the description shown on below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

180o Revolve 
The viewing angle will 
turn 180o. 

Selecting Preset Point 
Click on the arrow button and select the 
desired number from the pull-down list. 

Iris Control 
The purpose of iris control is to adjust brightness on target. It 
can be set as Auto Iris or Manual Iris. 

 Iris open: Click [+] button, to open the iris and brighten 
the picture. 

 Iris close: Click [-] button, to open the iris and reduce 
glare. 

Focus Control 
The focus function can be set as Auto Focus or Manual 
Focus. 

 Manual focus near: Click [+] button, the target will 
become farther. 

 Manual focus far: Click [-] button, the target will become 
nearer. 

Activate / Stop Auto Pan 
 Activate: Click the arrow button. 

 Stop: Click the rectangle button. 

Zoom Lens Control 
 To zoom in: Click [+] button, the viewing angle becomes 

narrower and target will become enlarged on the screen.

 To zoom out: Click [-] button, the viewing angle becomes 
wider and target will become smaller on the screen. 

Pan / Tilt the Dome Camera 
To control the pan and tilt movement of the dome camera 
simply click on the buttons:  

 To pan or tilt, just click on the 4-directions buttons for the 
desired direction. 

 To adjust the speed of the movement, just click on the 
arrow button beside “Speed” and select the desired 
speed from the pull-down list. The higher the number 
selected, the faster the speed. 
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5. Configuration of Web-Based User Interface 
The Configurations of the UNC7710 are presented as links in the margin of the Configuration Page. Simply 

click the relevant link for the settings you want to configure. 

 

5.1. Configuration Preview 

A/V Settings 
 Functions Description 

 

General 
Set the parameters of video and audio, and adjust the 

image quality of the video.  

 

PTZ Settings This function is unavailable for the UNC7710. 

 

External Sources 

Set the video source for channel 2 to 4, using network 

connection (IP Address). If the video source is a PTZ 

device, setup the parameters of the PTZ device here. 

 

On Screen Display Set the text and location to display on the video. 

Network Settings 
 Functions Description 

 

General 
Assign an IP Address and configure the relevant network 

parameters to the device. 

 

DDNS 

The DDNS (Dynamic Domain Name Service) is used to 

access the UNC7710 with an easy memorized name such 

as http://demo.ddns.com instead of http://61.220.235.172.

 

System  
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 Functions Description 

 

System Information 
Set various information about the name of the device and 

the language type, etc.  

 

Time Configuration Set the Date and Time of the device. 

 

User Create and delete users and passwords. 

 

Event 
 Functions Description 

 

General 
Set the [GPIN] and [Motion Detection] to trigger events. 

Select the action when an event is triggered. 

 

Motion Area Set the area on video for the motion detection. 

 

Email/FTP 
Set Email account or FTP site to receive the alarm 

message. 

 

Others 
 Functions Description 

 
Live Returns to the Live Video display on Home page. 

 
Reboot Closes the Web browser window and reboots the device. 

 

 



 

5.2. Configuration of A/V Settings 

– General 

Basic A/V Settings: 

 

 Audio: Enables and Disables the audio stream. 

 

 

Note: Since the MPEG-4 IR Network Camera is designed for long distance monitoring, the built-in

microphone is hard to receive the audio from the target actually, we recommend disable the audio.
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 Resolution 

There are 3 different resolutions to choose from: 

♦ D1: 720x480 NTSC / 720x576 PAL (DVD Standard resolution) 

♦ SIF: 352x240 NTSC / 352x288 PAL 

♦ QSIF: 176x112 NTSC / 176x144 PAL 

 Frame Rate: The frame rate can be set between 5 to 30 FPS. 

 Encoder Format 

Format can be selected for: 

♦ MPEG4 constant bit rates: Select MPEG4 and CBR. 

♦ MPEG4 variable bit rates: Select MPEG4 and VBR 

♦ Motion JPEG. 



 

 Bit rate 

For Motion JPEG format, there are 4 variable bit rates between Low and High quality. 

For MPEG4 format, there are 12 different constant bit rates (CBR) to choose from 64Kbps to 4Mbps, 

and 4 variable bit rates (VBR) between Low and High quality. 

If you are planning on using the device on an Internet connection, it is recommended that you select a 

constant bit rate that corresponds to your actual upload speed. It is also recommended that you 

modify the frame rate and resolution as well, otherwise the video stream may become blocky or 

otherwise distorted. The recommended settings for low-speed network connection are as follows: 

♦ 64Kbps: recommended settings are [QSIF, FPS<10] 

♦ 128Kbps: recommended settings are [QSIF, FPS<15] 

♦ 256Kbps: recommended settings are [SIF, FPS<10] 

♦ 512Kbps: recommended settings are [SIF, FPS<15] 

♦ 768Kbps: recommended settings are [Full D1, FPS<10] 

♦ 1Mbps: recommended settings are [Full D1, FPS<15] 

For higher frame rate use a variable bit rate instead. However, this is not recommended for Internet 

use. 

♦ Average Quality is recommended if the VBR is selected. 

♦ For Good Quality, full resolution (D1) and full frame rate (30/25 fps) it is recommended that not 

more than 4 users connect simultaneously.  

♦ For High Quality, full resolution (D1) and full frame rate (30/25 fps) it is recommended that not 

more than 2 users connect simultaneously. 

 Auto adjusts the frame rate under high-traffic icon:  

 When we enable this icon, system will auto detect the frame rate while using on the high-traffic 

networking environment. 

 Apply: Click this button to save the changes made. 
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Advanced A/V Settings: 

 

 Interlacing 

There are 2 modes available: Interlaced or Progressive. 

Interlaced mode is a storage mode. An interlaced video stream contains fields rather than frames, with 

each field containing half of the lines of a frame. 

A progressive video stream consists of only full frames. 

Interlaced video streams can bring a lower bit rate but may cause lower quality. 

 TV Standard: This is the read-only information, system will auto detect TV standard mode. 

 Sequence Mode 

There are 2 different modes available: 

♦ I-frames only  

♦ I-frames and P-frames  

P-frames, or predictive frames, are predicted based on prior P or I-frames plus some additional data. 

They have a much higher compression ratio than I-frames. 

I-frame only mode has very little compression resulting in large file sizes. 

I-frame and P-frame mode offers relatively good compression with medium file sizes. Although this 

requires more work on the host PC to decode the video. 
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 GOP Size: GOP stands for Group of Pictures. It defines the number of frames from one I-frame to the 

next. Since an I-frame uses very little compression, while P/B frames use much higher compression, a 

larger GOP size, results in smaller file sizes. For more information about I/P/B-frames, see below. 

For MPEG-4 there is no maximum GOP size defined. It can be as low as 1 V just an I-frame - or into 

the thousands. However, as the GOP size increases, the compression increases, and therefore the 

more likelihood of errors. A higher GOP size also results in higher buffering times. 

For DVDs the GOP size is 15. The default on the network camera is set to 60, which offers fair 

compression with a low likelihood of errors. 

 Peak Bitrate: This is used to set a maximum bitrate that can be achieved. This is useful for setting 

bitrates between the values that are available from the Video Encoder bitrate list. 

 Apply: Click this button to save the changes made. 

 

Image Adjustment: 

 

 Contrast, Brightness, Hue and Saturation: The value can be adjusted from -100 through 100. 

 Rotation: Rotation degrees run from 0 to 270 degrees for a permanent digital position. 

0: 0 degree    1: 90 degrees    2: 180 degrees    3: 270 degrees 

 Load Default: Click this button to set the image adjustments back to factory default. 

 Save: Click this button to save the changes made. 
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– Setting PTZ  

 
 PTZ Model: 

Support some kinds of PTZ models to control remote devices. 

Note: If your PTZ devices don’t support these models on the menu list, please contact with your 

distributor. 

 Camera ID: 

Define camera ID to connect video servers when using multi PTZ devices.  

 Serial Mode: 

Select the serial mode to RS232 or RS485. 

 COM port: 

This the read-only information and it will auto detect the COM port. 

 Serial data bits, Serial baud rate, Serial stop bits and Serial Parity:  

Every PTZ device has independent PTZ control protocol; please refer the PTZ product manual to 

check these settings. 
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– Setting External Sources 

 

 Video Select: Select the channel this external source will be displayed. 

 IP Address: Enter the IP address of the external source. 

 Video Channel: If the selected camera is connected to a Video Server, select the channel of the Video 

Server. 

 Http Port: Enter the port number used for the external source. 

 Username/Password: Enter the respective Username and Password if applicable. If no user has 

been set for the device, the default value should be root and pass respectively. 

 Video Type: Select MJPEG or MPEG4. The type must match the external source provided. 

 Rotation: Rotation degrees run from 0 to 270 degrees for a permanent digital position. 

0: 0 degree    1: 90 degrees    2: 180 degrees    3: 270 degrees 

 PTZ Model: Enter a PTZ model in case the device is a PTZ model or controls a PTZ. 

 Name: Enter a name for the external source. 

 RTSP Port: Enter a RTSP Port used for streaming in case the external source is a MPEG4 device. 

 Product Type: Select from MJPEG or MPEG4 Video Servers or IP Cameras. Please refer to the 

original document of the device for a better description. 

 Apply: Click on this button to save the changes made. 

 Test: Click on this button to validate the video connection and the live video will be displayed if the 

settings are correct. 



 

– Setting On Screen Display 

 

 On Screen Display: Select Enable/Disable to display/not display the text over the video. 

 OSD Text: Fill in the text string to display. The valid characters are a – z, A – Z, 0 – 9, !, @, #, $, %, &, 

*, (, and ). 

 

 

 

 

 

 

Note: The maximum display block area is 12X4 characters. String length more than 12 will feed

to next line, and totally 4 lines available. More than 4 lines will strip off. 
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OSD Coordinate X / Y: To change the location of text, just fill in the X and Y coordinate. 

Display Font Grey Level: Change the color of the displayed font. 

Apply: Click this button to save the changes made. 
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5.3. Configuration of Network Settings 

– General Settings 

 

 MAC Address: Display the MAC address information for this device. It’s read only. 

 IP Address: The IP address of the network camera. 

 Subnet Mask: Subnet mask of your LAN. Note that the IP Address above and Gateway IP Address 

below should be in the same subnet. 

 Device Name: Assign a name for the network camera. 

 Gateway Address: The gateway IP address for the network segment to which the device is 

connected. This device traffic to Internet should go through Gateway, if not setting this, only Intranet 

(LAN) can be accessed. 

 DNS Address 1, 2 and 3: The DNS server IP address used for resolving domain names to IP 

addresses. DNS Address 2 and 3 are optional. 

 IP Setting Mode 

Static IP - Manually assigned IP address. 

DHCP – If there is a DHCP server installed on your LAN, you can select DHCP to automatically assign 

an IP address for the device and obtain default gateway, and DNS server. 



 

 HTTP Port: Specify the HTTP web server listen port for client (browser) connection. Default uses port 

80 (HTTP standard port), valid range from 0 ~ 65535. 

 

Note: Before changing the listen port, user must add a port directive “:” in browser URL in order to 

get correct connection. (i.e. http://<IP>:<Port> , e.g. http://192.168.0.200:8000) to access the 

device with IP 192.168.0.200 and port with 8000). 

These features enable user to use the device behind NAT or IP Sharing devices which could 

access up to 65536 network cameras with one IP Address. 

 RTSP Port: The port on which the device will receive RTSP (streaming video) requests. 

 Apply: Click this button to save the changes made. 
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– Dynamic DNS Settings 
The DDNS (Dynamic Domain Name Service) is used when users want to access the network camera with 

an easy memorized name such as http://demo.server.ddns.com instead of http://61.220.235.172. This 

service could be useful when the network camera is located behind Dial-up ADSL or IP sharing devices, 

which does not have fix IP address, then it’s impossible to reach the network camera from Internet. 

When the network camera enables the DDNS service, it will “register” to the DDNS server with its 

information, such as server name to access, router virtual port number and updated frequency, etc. 

Then network camera automatically “update” to the DDNS server by a fix frequency, so even IP is changed 

by ISP, the DDNS server still could get and update internal database. Then, once users access from Internet 

with its register name, e.g. if registering with server name “demo” to DDNS server “server.ddns.com”, the 

network camera could be accessed by http://demo.server.ddns.com. 

 

 Dynamic DNS Settings: Select [Enable] if you wish to activate the DDNS service. 

 Device Name: Specify server name. This name setting also used by the DDNS service to recognize 

each server. 

E.g. if configure name as “demo” to DDNS address “server.ddns.com”, then this network camera can 

be accessed by URL http://demo.server.ddns.com after register to the DDNS server. 

 DDNS Server Address: Specify address of the DDNS server. 

 DDNS Connection Port: Specify the DDNS server listen port, and the default is “80”. 

 Router Incoming Port: Specify your router listen port for the DDNS server to redirect. The router may 

configure the different port for incoming (Internet request) and outgoing (Intranet request), e.g. it may 

configure to redirect Internet HTTP (port 80) request to Intranet port 8000, then, in this case, we must 

configure the “Router Incoming Port” to 80, and inside the network camera Network Settings should 

set HTTP port with 8000. 



 

 Update Time: Specify the network camera updated frequency in seconds, and the default is 600 (10 

minutes), this is interval that network camera will automatically send an updated packet to the DDNS 

server. 

 DDNS Message: Return messages from remote DDNS server, and some hints may help to diagnostic 

the reason if register fails. 

♦ DDNS addr. CGI fail: 

It means that network camera can’t communicate with Internet world. Make sure your Network 

Settings has correct subnet mask and default gateway, and DNS1 setting is valid and reachable. 

♦ Already registered: 

Another user had registered this name; please change your register name by changing “Device 

Name”. 

 Apply: Click this button to save the changes made. 

 

Example: 

To setup a network camera (IP address 192.168.0.200) behind a dialup ADSL router, and wish to access 

by name http://demo.server.ddns.com. And, the procedure is as below: 

1. Configure the ADSL router with PPPoE enable, assume the IP of the router is 192.168.0.254, and 

subnet mask is 255.255.255.0 

2. Go into "Virtual Server" or "Port Forwarding" configuration page in the ADSL router, set Port 80 to 

server IP 192.168.0.200 

3. In Network Settings > General page of the network camera, configure the settings with IP address 

192.168.0.200; subnet 255.255.255.0; DNS1 with valid DNS address such as 168.95.192.1 or 

168.95.1.1; gateway IP address with 192.168.0.254 (router’s IP); HTTP port with port 80. 

4. Configure the Device Name with “demo”. 

5. Configure Dynamic DNS Settings with Enabled; DDNS Server Address with “server.ddns.com”; DDNS 

Connection Port with port 80; Router Incoming Port with 80; and Update Time with 600 (10 minutes). 

Finally, clicks [Apply] button. 

6. If DDNS message success, then enter URL http://demo.server.ddns.com on browser. Consequentially, 

it will show the home page of the network camera. 

 

 

 

30 



 

31 

5.4. Configuration of System 

– System Information 

 

 MAC Address: Display the MAC address information for this device. It’s read only. 

 Language: Alternative language option. User may change the language of web contents for different 

application. 

 Description: Useful as an administrative identifier. Does not affect the operation of the device. 

 Location: Useful for identifying the position of the device. Does not affect the operation of the device. 

 Model: Displays the model number for the device. 

 Firmware Version: Display firmware version information. 

 Load Default: Click this button to restore the settings back to factory default. 

 Apply: Click this button to save the changes made. 
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– Time Configuration 

 

 Time Mode 

♦ Synchronize with NTP server: Synchronize the current time with a NTP server over Internet. 

♦ Set Manually: Manually set the time. 

 
Click on [Synchronize with computer time] button to set the date/time of the network camera as 

your PC’s. 

Set the date and time by clicking on the arrow button beside each field and select the value from 

the pull-down list. 

Click on [Apply] button to save the configuration. 

 Time Zone: Click on the arrow button and select the appropriate time zone from the pull-down list. 

 NTP Server 1, 2 and 3: Assign the NTP servers to use for time synchronization. A list of NTP servers 

can be found at: http://www.eecis.udel.edu/~mills/ntp/clock2a.html 

 Apply: Click this button to save the changes made. 

 

http://www.eecis.udel.edu/~mills/ntp/clock2a.html
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– User Settings 

 

Add User 

To add a user, enter the user name and password in the respective fields. Select the [Group] and the 

permission of each channel, and then click on [Add User] button. 

 The user in Administrator group has all permission to operate the device. 

 The user in General group can be configured to have limited permission to operate the channels. 

Delete User 

To remove a user, select the user from the list, and then click on [Delete User] button. 

 

Note: 

 Totally 10 users can be added. 

 The first added user must have administrative right (Administrator group), and must be the 

last one to be removed. 

 The username and password cannot contain the “:”, “,” characters. And the length must be 

between 1 and 7 characters. 

 The user cannot be modified, to change the data of the user, just remove it and then add it 

with the modified data. 
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5.5. Configuration of Event  

– General Settings 

 

 Trigger: System provides “GPIN” and “Motion Detection” to trigger events. 

♦ GPIN & GPIO Input Status: They are auto detected to display the status. 

♦ Motion Detection: When user would like to use “Motion Area” function and this checkbox must 

be enabled. 

 Action: Select the actions when an event is triggered. 

♦ FTP Image: When an event is triggered, the snapshot of video will be send to the indicated FTP 

site. Please set the FTP site in “FTP Setting” function. 

♦ Mail Image: When an event is triggered, the snapshot of video will be send to the indicated Email 

address. Please set the Email address in “E-Mail Setting” function. 

♦ GPOUT: It is auto detected to display the status. 

♦ Relay Out: Turn “Off” or “ON” for relay out. 

♦ Alert Message Status: They are auto detected to display the status with the recording application 

software. 

 Apply: Saves the changes made. 
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– Motion Area 

 

 

The “Motion Detection” icon (Configuration>Event>General>Trigger) must be enabled when use 

this function. 

To set the area on video for motion detection: 

1. Use Mouse to drag out a detection area on the video. 

2. Left-click the area and drag the corner to change the size. 

3. Right-click the area and select “Property”. 

4. Check “Enable”, click “OK” and click “Apply”. 

Note: Green blocks indicate this area is enabled for detection. 

      Red blocks indicate this area is not enabled for detection. 

 Apply: Saves the changes made. 
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– E-Mail / FTP Settings 

 

 E-mail Setting: The “E-Mail Image” icon (Configuration>Event>General>Active) must be enabled 

when use this function. 

♦ Mail From: Enter the mail address of the mail sender. 

♦ Receipt To: Enter the mail address of the mail receiver. 

♦ Mail Server: Enter the mail server name or IP address. 

♦ Authorization: Disable or enable the security for mail authorization. 

♦ Account ID & Password: Enter the user name and password for the mail sender. 

 FTP Setting: The “FTP Image” icon (Configuration>Event>General>Active) must be enabled 

when use this function. 

♦ Host Name: Enter the IP address of the FTP server. 

♦ User Name & Password: Enter the user name and password for the FTP server. 

♦ Mail Server: Enter the mail server name or IP address. 

♦ Authorization: Disable or enable the security for mail authorization. 

♦ Account ID & Password: Enter the user name and password for the mail sender. 

 Apply: Saves the changes made. 

 

 



 

6. Specifications 
 

System 
CPU 32-Bit RISC Processor 

ROM 4MB Flash ROM 

RAM 32MB SDRAM 

Watchdog Chip to monitor system voltage tolerance and abnormal program execution 

Image Compression MPEG-4 Simple Profile (SP), JPEG, MJPEG  

Resolution Full D1 (4SIF): NTSC = 720 x 480; PAL = 720 x 576 
SIF: NTSC = 352 x 240; PAL = 352 x 288 
QSIF: NTSC = 176 x 112; PAL = 176 x 144 

Bit Rate 16K ~ 4M bits/sec (CBR/VBR configurable) 
High quality VBR settings for MJPEG can reach to 10Mbps 

Video Adjustment Brightness, Contrast, Hue, Saturation, Frame rate, Bit rate (Constant Bit Rate (CBR), 
Variable Bit Rate (VBR) w/ quality levels), Group of Pictures (GOP) size, Frame 
Sequence (I-Frame, I-Frame/P-Frame), Interlaced/Progressive Scanning 

Video Performance Up to 30(NTSC) / 25(PAL) frames per second 

Network Interface 10/100 Base-T Ethernet 

Protocols TCP(UDP)/IP, ICMP, HTTP, TFTP, FTP, Telnet, SMTP, DHCP, NTP, DNS, DDNS, 
RTSP, RTP/TCP(UDP) 

Recording Directly from Web UI while viewing the live video stream 
Recording Software 

Installation Software IP Installer (Win32 Application) 

Firmware Upgrade Local or remote software upgradeable using FTP; Customized Web UI upgradeable 
via FTP and Telnet 

Client PC Requirement Computer:    Pentium 4 2.0GHz or equivalent, 512MB RAM 
Operating System: Microsoft Windows 98se/Me/2000/XP 
Web Browser:  Microsoft Internet Explorer 5.x or 6.x 
Software Required: Microsoft DirectX 9.0c, Macromedia Flash 6, MPEG-4 Software 
Codec 

Security Multi-tiered access control for configuration 

Connectors Network: 1x RJ-45 connector 
Power:1x AC Cord (Not included with PoE model) 
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Camera 
System NTSC / PAL auto detection 

Image Device 1/3” Sony Super HAD CCD 

Total Pixels NTSC:768(H) x 494(V) 
PAL: 752(H) x 582(V) 

Resolution More than 540 TV Lines 

Horizontal & Vertical 
Synchronization 

NTSC:15.734KHz, 60Hz 
PAL: 15.625KHz, 50Hz 

Synchronization Internal 

Infrared Radiant 
Distance 

30 meters 

Infrared LED 850nm / 7Units 
CDS Auto Control 

Minimum Illumination Normal: 0.2 Lux at F1.2 
IR On: 0 Lux at F1.2 

S/N Ratio More than 48dB (AGC Off) 

Back Light 
Compensation 

ON / OFF selectable 

Auto Electronic Shutter ON / OFF selectable 

Gain Control Average AGC 

White Balance Auto 

Water Proof Standard IP66 Standard 

Power Supply Non PoE model: Input 90V ~ 240V AC 
PoE model: Built-In PoE (IEEE 802.3af) 

Power Consumption 6W (IR Off) / 8.5W (IR On) 

Operation Temperature -20oC ~ +60oC 

Operation Humidity 0% ~ 90% 

Dimension (L x W x H) 235mm x 98mm x 90mm 

Weight  1260 g 
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Appendix A Upgrading the Firmware 
The UNC7710 firmware is contained in Flash Memory, a silicon chip allowed to be erased and re-written. It 

provides an easy way to update the firmware without change any parts; just simply load the newest 

firmware from network. 

 

The following procedures are to update the firmware: 

Check firmware Version 
Open the home page of UNC7710 in your web browser, go into Configuration -> System -> System 

Information, you will see the version--" Firmware Version=2.11R27.04.PN", which indicates the 

currently firmware version is 2.11. 

 

Upgrade Procedure via FTP 
1. Download the newest firmware and unzip it into your local drive, for example "C:\temp". Then, 

confirm the "flash.bin" file exists in this folder. 

2. Restart the network camera by clicking on the <Reboot> button on Configuration page. 

 

Caution: You must reboot the network camera before doing the following procedures; 

otherwise, some occasional internal conflicts may endanger the Flash devices. 

3. Start the FTP session and log in to the network camera. 

For example, in our case for Windows XP: 

Enter DOS by Start > All Programs > Command Prompt" 

Change to the folder where the latest flash.bin exists. 

Start ftp session by enter “ftp <Network camera’s IP Address>  

Enter "root" as USERNAME, "pass" as PASSWORD if no user in User List record .In case any 

user list exists, you will have to use your administrator's USERNAME and PASSWORD to login. 

4. Set FTP to binary mode using the command "bin". 

In FTP session window, enter "bin" 

5. Upload the firmware into the network camera by FTP "put" command. 

In FTP session window, enter "put flash.bin" 

In FTP session window, enter "bye" to quit FTP session. 

6. FTP session may freeze for around 1 minute to transfer and automatically upgrade the firmware. 

During that time, ping the network camera until get constant reply, which means system had 

completed upgrading and rebooting, then open browser to verify the firmware version been 

updated. 
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Note: If FTP session quits immediately after issued by command, you should continue pinging the 

network camera instantly. If the network camera replies to the ping command right after pinging, it 

means the network camera may not enter the self-programming stage to update the firmware. If not

updated, then you should reboot the network camera and back to step 3 to try again. 
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or example, the network camera IP address is 192.168.0.200, then 

C:\Documents and Settings\Administrator>cd \temp 

C:\temp>ftp 192.168.0.200 

Connected to 192.168.0.200. 

220 192.168.0.200    Network camera FTP server ready. 

User (192.168.0.200:(none)): root 

331 Password required for root. 

Password:  

230 User root logged in. 

ftp> bin 

200 Type set to I. 

ftp> put flash.bin 

200 PORT command successful. 

150 Opening BINARY mode data connection for flash.bin 

226 Transfer complete. 

ftp: 2097152 bytes sent in 10.11Seconds 207.43Kbytes/sec. 

ftp> bye 

221 Goodbye.  <=Quit ftp session immediately 

    <=if the window is frozen, please open another dos session 

C:\temp>ping -t 192.168.0.200 

 

Pinging 192.168.0.200 with 32 bytes of data: 

 

Request timed out. 

Request timed out. 

Reply from 192.168.0.200: bytes=32 time=2ms TTL=255 

Reply from 192.168.0.200: bytes=32 time=1ms TTL=255 

Reply from 192.168.0.200: bytes=32 time<10ms TTL=255 

 

Ping statistics for 192.168.0.200: 

    Packets: Sent = 13, Received = 5, Lost = 8 (61% loss), 

Approximate round trip times in milliseconds: 

    Minimum = 0ms, Maximum =  2ms, Average =  0ms 

Control-C 

^C 

Key in the path stores the “flash.bin” 

Key in this command, change the IP to yours 

Input the account, default is “root” 

Input the password, default is “pass” 

Key in this command 

Key in this command 

Key in this command 

Key in this command and wait the upgrade is complete.

These messages means the 
upgrade is finished 

Press Ctrl+C to terminate the detection



 

C:\temp> 
 

 

Note: Flash products can become damaged if the updating operation is not performed correctly. So 

please follow up above procedures carefully. 
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